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UX checklists with best design practices, accessibility guidelines, design system checklist, tables UX checklist, UX research methods, form design UX and flowcharts.Given just how complex the web has become, it’s easy to overlook some fine little details just before the big release. And sometimes it’s difficult to pick out just the right technique or
strategy to address a particular problem. That’s where design checklists can help — and there a few new ones that you might find helpful, too.Checklist DesignChecklist Design is an ever-growing collection of best design practices, all gathered in one single place. You’ll find pretty much everything from checklists for standalone pages to elements and
flows, as well as topics and branding. A neat little resource created by George Hatzis.A comprehensive checklist for everything Ul: from form controls to password recovery.Design System ChecklistDesign System Checklist is an open-source checklist to planning, building and growing a design system. It includes the foundation of things to keep in
mind for design language, design tokens, core components, tooling and project management. Beautifully created and maintaned by fine folks from reshaped. Also, you might want to check Design Systems Handbook as well and you can download the Design System Checklist in Figma.A good reminder of things to keep in mind in your design system, in
the Design System Checklist.Accessibility Not-ChecklistAccessibility Not-Checklist is a thorough guide through accessibility, with points grouped by topics and success criteria, with filters for WCAG 2.0 and WCAG 2.1 and best practice recommendations. You can sort the checklist by topic and by role. A fantastic tool by fine folks at intopia.A very
thorough accessibility checklist, grouped by topics and success criteria. Good UX is about good accessibility.A11y Project ChecklistAl1ly Project Checklist is a yet another very thorough checklist for accessibility that goes into all the fine detail from forms and controls to video, audio and animation. It also links to specific parts of WCAG in every
individual section with further examples and guidelines. Neat!A11ly Project Checklist with a very detailed overview of accessibility issues to consider with common components: from lists to video and audio. A goldmine!You and your team are working on a design system? The Design System Checklist template for Trello is a great example of how to
structure your work and keep everyone involved on the same page. Even if you're not a Trello user, the template provides some valuable ideas for creating your own checklist of things to take care of when working on a mammoth project like this.Everything is ready in a Trello template: from UI components to design tokens to accessibility
touchpoints.Gov.UK Design System Components (Figma)The lovely team behind Gov.UK has released a full collection of styles and components designed for UK Government services. During the design process, the team has tested and validated the design of the components, and we can use them to explore the states or conditions that we perhaps
haven’t considered in our design just yet.You can also check the GOV.UK Prototype Kit if you want to install all components locally, and GOV.UK Design System to explore how to use the styles and components in prototyping.All form components in all states, in one place: GOV.UK Design System Components Figma file.Complex Tables UX Treeln his
article on Architecting a complex table, Slava Shestopalov explores how to design and architect advanced tables — with a very comprehensive table tree checklist of all those fine details that are often forgotten or overlooked.Everything that goes into a complex table, with various states for rows, columns and cells: complex tables UX checklist.UX
Recipe is a helpful little tool to discover and choose some of the UX project tools and techniques for your project. It also allows you to estimate the amount of time require for the work done. All tools are broken down into groups, and if you click on the hashtags, you’ll find plenty of useful resources for each category. Created and maintained by
Alecsandru Grigoriu.Choose your own UX adventure, with the UX Recipe.UX Research Methods FlowchartHow do you choose what UX research methods works best for you? There are at least 20 popular methods, and a handy UX Research Methods Flowchart by Norman-Nielsen Group helps you find the right one.It provides an overview of common
strategies, grouped into behavioral, attitudinal, qualitative and quantitative methods. Once you know what insights you are after, you can pick your strategy using the chart.How to choose the right UX research method? UX Research Methods Flowchart has got your back.Form Design UX ChecklistWith web form design, it can be quite difficult to
figure out just the right component to use when asking a particular question. The team behind Lyft has created a flow chart to make it easier for designers (and not designers alike) to make decisions for their forms.In an article about form selection patterns, Runi Goswami describes the struggles the team went through when designing a segmented
control, and how they ended up with a form selection control flow chart as a result. How to make a design decision around forms? Lyft’s Form Design UX Checklist is here to help.Decision Trees For Design System ComponentsDesign systems often come in various flavors. Surely there will be basic components, color, typography and spacing, but often
also more sophisticated components, usage guidelines, accessibility considerations and live previews. Additionally, Workday Canvas Design System includes flow charts for deciding what components to use, with examples of the outcome that designers and non-designers can follow to make their decisions.Workday’s Canvas design system includes
decision trees and flow charts for many patterns and components.Interaction Design ChecklistThe IxD Checklist that Aaron Legaspi and Amit Jakhu created helps us form a better understanding of interaction. Whenever you’re building some kind of interaction — be it a control, navigation, or an entire interface — you can use the checklist to evaluate
your design against affordance, simplicity, structure, consistency, accessibility, tolerance, and feedback to ensure it is easy to use for everyone.Evaluate the interaction of your design with the Interaction Design Checklist.Markwhen: Text-to-Timeline is an incredible little tool to generate timelines, e.g. for project planning or life timeline! You write
markdown-ish text and it gets converted into a nice looking cascading timeline. Also available as a VS Code Extension.Generate a timeline out of plain text, with Markwhen.And That’s A Wrap!If you are looking for more gems like this one, we’ve published a few UX guides with checklists over the last few years, so feel free to continue exploring there.
Happy checklisting, everyone! (il) The Design Review Checklist is a comprehensive set of best practices and guidelines for evaluating the quality of a design. It covers topics such as design principles, user experience, user interface, accessibility, usability, performance, security, and more. The checklist includes questions such as "Is the design visually
appealing?" and "Does the design use appropriate color schemes?" to ensure that the design meets the criteria for a successful product. It helps designers and stakeholders to assess the quality of a design, identify potential problems, and develop strategies to improve the design. The Design Review Checklist provides a comprehensive overview of the
design process, helping to ensure that the final product is of the highest quality. Learn to design with your user’s needs and expectations in mind by applying Jakob Nielsen and Rolf Molich’s Ten User Interface Guidelines. These heuristics have been reflected in many of the products designed by some of the most successful companies in the world
such as Apple, Google, and Adobe. Further evidence of how their design teams incorporate these rules into their design process is reflected in the user interface guidelines published and shared by these companies. This article will teach you how to follow the ten rules of thumb in your design work so you can further improve the usability, utility, and
desirability of your designs.Nielsen and Molich's 10 User Interface Design Guidelines]Jakob Nielsen, a renowned web usability consultant and partner in the Nielsen Norman Group, and Rolf Molich, another prominent usability expert, established a list of ten user interface design guidelines in the 1990s. Note that there is considerable overlap between
Nielsen and Molich's heuristics and Ben Shneiderman'’s 'eight golden rules'. These 10 rules of thumb further iterate upon Shneiderman’s eight golden rules 4 years after Shneiderman'’s initial publication.Visibility of system status. Users should always be informed of system operations with easy to understand and highly visible status displayed on the
screen within a reasonable amount of time.Match between system and the real world. Designers should endeavor to mirror the language and concepts users would find in the real world based on who their target users are. Presenting information in logical order and piggybacking on user’s expectations derived from their real-world experiences will
reduce cognitive strain and make systems easier to use.User control and freedom. Offer users a digital space where backward steps are possible, including undoing and redoing previous actions.Consistency and standards. Interface designers should ensure that both the graphic elements and terminology are maintained across similar platforms. For
example, an icon that represents one category or concept should not represent a different concept when used on a different screen.Error prevention. Whenever possible, design systems so that potential errors are kept to a minimum. Users do not like being called upon to detect and remedy problems, which may on occasion be beyond their level of
expertise. Eliminating or flagging actions that may result in errors are two possible means of achieving error prevention.Recognition rather than recall. Minimize cognitive load by maintaining task-relevant information within the display while users explore the interface. Human attention is limited and we are only capable of maintaining around five
items in our short-term memory at one time. Due to the limitations of short-term memory, designers should ensure users can simply employ recognition instead of recalling information across parts of the dialogue. Recognizing something is always easier than recall because recognition involves perceiving cues that help us reach into our vast memory
and allowing relevant information to surface. For example, we often find the format of multiple choice questions easier than short answer questions on a test because it only requires us to recognize the answer rather than recall it from our memory.Flexibility and efficiency of use. With increased use comes the demand for less interactions that allow
faster navigation. This can be achieved by using abbreviations, function keys, hidden commands and macro facilities. Users should be able to customize or tailor the interface to suit their needs so that frequent actions can be achieved through more convenient means.Aesthetic and minimalist design. Keep clutter to a minimum. All unnecessary
information competes for the user's limited attentional resources, which could inhibit user’s memory retrieval of relevant information. Therefore, the display must be reduced to only the necessary components for the current tasks, whilst providing clearly visible and unambiguous means of navigating to other content.Help users recognize, diagnose
and recover from errors. Designers should assume users are unable to understand technical terminology, therefore, error messages should almost always be expressed in plain language to ensure nothing gets lost in translation.Help and documentation. Ideally, we want users to navigate the system without having to resort to documentation. However,
depending on the type of solution, documentation may be necessary. When users require help, ensure it is easily located, specific to the task at hand and worded in a way that will guide them through the necessary steps towards a solution to the issue they are facing.Google Inc., the multibillion-dollar technology company, certainly produces designs
that reflect the above heuristics. Jon Wiley, the head designer of Google Search in 2012 once said:“When I think of design and creating great user experiences, I generally think of it in terms of three things: usability, utility and desirability.”Nielsen and Molich’s 10 user interface guidelines cover these three key components of user experience quite
nicely, which means you can likely improve the user experience of your designs by following these guidelines!Learn How Adobe Integrates Nielsen and Molich's Ten User Interface Design GuidelinesAdobe Systems Incorporated, the large North American computer software company, is a great example of how designs reflecting Nielsen and Molich’s
ten user interface guidelines can lead to success for a company. One of their most popular products, Adobe Photoshop, which is a raster graphics editor exhibits the characteristics of a well designed user interface that reflects these guidelines.We will take a closer look at how Adobe Photoshop reflects each of these guidelines in order to inspire you to
improve the usability, utility, and desirability of your own designs by incorporating the 10 rules of thumb into your own work.1. Visibility of System StatusPhotoshop does a great job of letting the user know what’s happening with the program by visually showing the user what their actions have led to whenever possible. For example, when users move
layers around in the Layers palette, they can visually see the layer being represented as physically dragged within the space.The cursor graphic goes from representing an open-hand to a gripped hand when the user drags a layer around within the Layers palette. This makes it easier to instantly understand the system status. Additionally, Adobe’s
choice of using a ‘hand’ is a great example of the second guideline where the system matches the real world.© Adobe Systems Incorporated, Fair Use2. System Match to the Real WorldAn example of Photoshop mimicking the real world in terms and representations that their target users would understand, is where they design the information
structure and terminology to mirror the same wording we would use in the world of photography or print media. Familiar concepts and terms like RGB, Hue/Saturation/Brightness and CMYK are used to represent color, while various tools like the dodge tool and the burn tool mimics a traditional darkroom technique for photographs.Photoshop’s
Dodge Tool and Burn Tool mimics a traditional darkroom technique for photographs© Adobe Systems Incorporated, Fair Use Photoshop utilizes the term, “Exposure”, as commonly used in the world of photography.© Adobe Systems Incorporated, Fair Use3. User Control and FreedomPhotoshop is very good at providing users with control every step
of the way. As the user makes changes to an image or adds various artistic effects, they are able to quickly and easily take a step backwards if they make an error, for instance.The users are in control as they can take a Step Backward or Step Forward under the Edit menu, or alternatively they can use Photoshop’s keyboard shortcuts like Alt+Ctrl+Z,
for example.© Adobe Systems Incorporated, Fair Use4. Consistency and StandardsPhotoshop maintains a standard layout and look and feel when it comes to the menu bar. They also utilize commonly known terminology such as “New...”, “Open...”, “Save As...”, etc.The File menu in Photoshop displays a variety of highly familiar options.© Adobe
Systems Incorporated, Fair Useb5. Error PreventionTo prevent users from making errors, Photoshop provides a brief description or label of the tools when a user hovers over it to help make sure users are using the proper tool for the task at hand.The user hovers over the eraser icon and Photoshop displays the “Eraser Tool” label.© Adobe Systems
Incorporated, Fair Use Get your free template for “Bad UI Design Mistakes and How to Avoid Them” 6. Recognition rather than RecallWhether it be making a selection from the artistic filters menu, or opening a new image file, Photoshop provides a sample view for users to make the right choice. This allows for the user to visually recognize what
they’re looking for instead of having to recall the name or typing it in to search for it. Perhaps you have encountered other photo editing programs which ask you to recall and type the name of the file you want to work on. This can indeed be really difficult to recall as it is often something to the effect of: 29412 09342.JPG.The user is able to visually
recognize the sunset image by its thumbnail and select it.© Adobe Systems Incorporated, Fair Use7. Flexibility and Efficiency of UseOne of the many reasons for frequent users to love Photoshop is for its flexibility and efficiency. Users are able to utilize its flexibility by organizing and adding to their Workspace, as well as making things more efficient
by saving it for future use.Photoshop gives frequent users the ability to save their preferred workspace-setup.© Adobe Systems Incorporated, Fair Use8. Aesthetic and Minimalist DesignThe toolbar in Photoshop only displays the icons and is neatly tucked to the side to help keep clutter to a minimum, and maintain a minimalist aesthetic.The
Photoshop toolbar is minimalist and avoids clutter by representing the tools with icons only.© Adobe Systems Incorporated, Fair Use9. Help Users Recognize, Diagnose and Recover from ErrorsWhenever there is an error, Photoshop provides dialogue that lets the user know what went wrong and how to fix it.In this error message for the user’s
misuse of the clone stamp, Photoshop explains what went wrong, the reason why and how the user should proceed from there.© Adobe Systems Incorporated, Fair Usel10. Help and documentationHelp and documentation can be accessed easily via the main menu bar. From there, you can find a wide variety of help topics and tutorials on how to make
full use of the program.The window displays information on how to create rollovers in the context of web graphics. The user is also able to see a list of topics on the side menu.© Adobe Systems Incorporated, Fair Use10 Steps to Improve Usability, Utility, and Desirability by Implementing Nielsen and Molich’s User Interface Design GuidelinesAs a
designer, you should have the ability to critique the designs of your own as well as the work of others with well supported reasoning. Applying Nielsen and Molich’s 10 rules of thumb in evaluating interface design will help you recognize any potential issues as well as guide you and your team in creating better experiences for your users. Here’s a
worksheet for you to practice with as you learn the skill of recognizing whether or not these rules have been applied and when these rules have been violated. Finally, it’s time to improve the website or app by further implementing the 10 guidelines.Download PDF here.The Take AwayWhen you follow Nielsen and Molich’s 10 user interface guidelines
you will design with usability, utility and desirability in mind. Just as the designers of successful companies like Apple, Google, and Adobe, you'll be able to support your design decisions with well researched heuristics and be confident in creating designs that are both usable and beautiful. To practice recognizing these 10 rules of thumb, go ahead
and work through the exercise outlined in the attached file from the above section.References and Where to Learn MoreTo find more information on Jakob Nielsen’s ‘Enhancing the Explanatory Power of Usability Heuristics’ please seeCourse: Ul Design Patterns for Successful SoftwareHero Image: Barry Schwartz. Flickr, CC BY-NC 2.0 Photo by Jess
Bailey on UnsplashAs someone who has always been interested in design, I’ve come to appreciate the importance of design guidelines in creating cohesive and effective designs. Design guidelines, also known as style guides or design systems, are essentially a set of rules and principles that guide designers in creating consistent and well-designed
products.Design guidelines are a set of principles and recommendations that are used to ensure consistency and best practices in the design of a product, application, or website. They provide a framework for designers to follow, ensuring that the end product is functional, easy to use, and aesthetically pleasing. In this blog post, I will explore what
design guidelines are and give an example of the Human Interface Design Guidelines (HIG) from Apple.Design guidelines can cover a range of topics, including typography, color theory, layout, accessibility, and user experience. They are often developed by organizations that have a strong brand identity and want to ensure consistency across all their
products. Design guidelines can also be created by individual designers who want to establish their own design principles and best practices.The benefits of using design guidelines are clear. They help to establish a clear and consistent design language, reduce development time, improve usability, and increase brand recognition. Additionally, they
help designers to avoid common mistakes and ensure that their designs are accessible to all users.One of the most well-known sets of design guidelines is the Human Interface Design Guidelines from Apple. These guidelines were first introduced in 1984 and have been updated many times since then. They are designed to provide a framework for
developing user interfaces that are intuitive, efficient, and aesthetically pleasing.The Human Interface Design Guidelines cover a range of topics, including layout, typography, color, and user experience. They provide detailed guidance on each of these topics, with examples and best practices to help designers create interfaces that are consistent with
Apple’s brand identity.One key aspect of the Human Interface Design Guidelines is the focus on user experience. Apple believes that the user experience is the most important aspect of any product, and the guidelines reflect this philosophy. The guidelines emphasize the importance of simplicity, clarity, and consistency in all aspects of the user
interface.For example, the guidelines recommend that designers avoid cluttered interfaces and instead focus on a clear hierarchy of information. This can be achieved through the use of typography, color, and layout. The guidelines also recommend that designers use a limited color palette to create a cohesive and consistent look and feel across all
parts of the interface.Another important aspect of the Human Interface Design Guidelines is accessibility. The guidelines provide detailed guidance on accessibility, including how to design interfaces that are easy to navigate for users with vision, hearing, or motor impairments.Apple believes that all users should be able to use their products,
regardless of their abilities or disabilities.For example, the guidelines recommend that designers use clear and legible fonts, with a minimum font size of 11 points. They also recommend using high contrast colors to ensure that text is easy to read for users with visual impairments. Additionally, the guidelines provide guidance on designing interfaces
for users with hearing or motor impairments, including how to use voiceover technology and how to design interfaces that can be navigated with a keyboard.In addition to user experience and accessibility, the Human Interface Design Guidelines also cover other important topics, including animations, touch input, and notifications. For example, the
guidelines recommend using subtle and natural animations to provide feedback to users, and they provide guidance on how to design interfaces that are optimized for touch input.One of the most important aspects of the Human Interface Design Guidelines is the focus on consistency. Apple believes that consistency is essential for creating a great
user experience, and the guidelines reflect this philosophy. The guidelines provide detailed guidance on how to create a consistent look and feel across all parts of the interface, including icons, buttons, and menus.For example, the guidelines recommend using a standard set of icons and providing clear labels for all buttons and menus. They also
recommend using consistent terminology and ensuring that all interface elements are aligned correctly. These principles help to ensure that users can easily understand and navigate the interface, even if they are new to the product.To illustrate the importance of design guidelines, let’s consider the example of a mobile app. Without design
guidelines, it is likely that different designers working on the app would create different styles and layouts. This would make the app appear disjointed and confusing to users. Additionally, without clear guidelines on typography and color, it is possible that the app could be difficult to read or use.On the other hand, by following design guidelines,
designers can create a cohesive and user-friendly interface. The app will have a consistent look and feel, making it easy for users to navigate and use. The guidelines will ensure that the app is accessible to all users, regardless of their abilities. This results in a better user experience, which is likely to result in higher user satisfaction and retention.In
conclusion, design guidelines are an essential tool for designers. They provide a framework for creating consistent, functional, and aesthetically pleasing designs. The Human Interface Design Guidelines from Apple are an excellent example of comprehensive design guidelines that focus on user experience, accessibility, and consistency. By following
these guidelines, designers can create interfaces that are intuitive, easy to use, and accessible to all users. The Infrastructure Design Criteria* (IDC) defines the criteria and parameters for design and construction of Land Transport Facilities for the Land Transport Authority. *Some chapters and annexes of the IDC are not available for download. The
full IDC will only be issued to parties contracted with LTA. For feedback on the IDC, please email lta idc@lta.gov.sg. The Civil Design Criteria (CDC) contains requirements for the design and detailing of all Civil Engineering Works for the Land Transport Authority. Civil Design Criteria (Revision A2, Sep 2019) (PDF, 6.1MB) For feedback on the CDC,
please email cdcmw_feedback@lta.gov.sg. The SDRE sets standards and guidelines for common road elements such as drains, kerbs and pavements as a reference for road construction. The Standard Details of Road Elements (Revision G - MAR 2025) (PDF, 910kB) The J-walk Guidelines set the guidelines for Wayfinding Signage across the Jurong
Lake District 2nd Storey Pedestrian Network. J-Walk Guidelines (PDF, 1.1MB) Learn to design with your user’s needs and expectations in mind by applying Jakob Nielsen and Rolf Molich’s Ten User Interface Guidelines. These heuristics have been reflected in many of the products designed by some of the most successful companies in the world such
as Apple, Google, and Adobe. Further evidence of how their design teams incorporate these rules into their design process is reflected in the user interface guidelines published and shared by these companies. This article will teach you how to follow the ten rules of thumb in your design work so you can further improve the usability, utility, and
desirability of your designs.Nielsen and Molich's 10 User Interface Design Guidelines]Jakob Nielsen, a renowned web usability consultant and partner in the Nielsen Norman Group, and Rolf Molich, another prominent usability expert, established a list of ten user interface design guidelines in the 1990s. Note that there is considerable overlap between
Nielsen and Molich's heuristics and Ben Shneiderman’s 'eight golden rules'. These 10 rules of thumb further iterate upon Shneiderman’s eight golden rules 4 years after Shneiderman’s initial publication.Visibility of system status. Users should always be informed of system operations with easy to understand and highly visible status displayed on the
screen within a reasonable amount of time.Match between system and the real world. Designers should endeavor to mirror the language and concepts users would find in the real world based on who their target users are. Presenting information in logical order and piggybacking on user’s expectations derived from their real-world experiences will
reduce cognitive strain and make systems easier to use.User control and freedom. Offer users a digital space where backward steps are possible, including undoing and redoing previous actions.Consistency and standards. Interface designers should ensure that both the graphic elements and terminology are maintained across similar platforms. For
example, an icon that represents one category or concept should not represent a different concept when used on a different screen.Error prevention. Whenever possible, design systems so that potential errors are kept to a minimum. Users do not like being called upon to detect and remedy problems, which may on occasion be beyond their level of
expertise. Eliminating or flagging actions that may result in errors are two possible means of achieving error prevention.Recognition rather than recall. Minimize cognitive load by maintaining task-relevant information within the display while users explore the interface. Human attention is limited and we are only capable of maintaining around five
items in our short-term memory at one time. Due to the limitations of short-term memory, designers should ensure users can simply employ recognition instead of recalling information across parts of the dialogue. Recognizing something is always easier than recall because recognition involves perceiving cues that help us reach into our vast memory
and allowing relevant information to surface. For example, we often find the format of multiple choice questions easier than short answer questions on a test because it only requires us to recognize the answer rather than recall it from our memory.Flexibility and efficiency of use. With increased use comes the demand for less interactions that allow
faster navigation. This can be achieved by using abbreviations, function keys, hidden commands and macro facilities. Users should be able to customize or tailor the interface to suit their needs so that frequent actions can be achieved through more convenient means.Aesthetic and minimalist design. Keep clutter to a minimum. All unnecessary
information competes for the user's limited attentional resources, which could inhibit user’s memory retrieval of relevant information. Therefore, the display must be reduced to only the necessary components for the current tasks, whilst providing clearly visible and unambiguous means of navigating to other content.Help users recognize, diagnose
and recover from errors. Designers should assume users are unable to understand technical terminology, therefore, error messages should almost always be expressed in plain language to ensure nothing gets lost in translation.Help and documentation. Ideally, we want users to navigate the system without having to resort to documentation. However,
depending on the type of solution, documentation may be necessary. When users require help, ensure it is easily located, specific to the task at hand and worded in a way that will guide them through the necessary steps towards a solution to the issue they are facing.Google Inc., the multibillion-dollar technology company, certainly produces designs
that reflect the above heuristics. Jon Wiley, the head designer of Google Search in 2012 once said:“When I think of design and creating great user experiences, I generally think of it in terms of three things: usability, utility and desirability.”Nielsen and Molich’s 10 user interface guidelines cover these three key components of user experience quite
nicely, which means you can likely improve the user experience of your designs by following these guidelines!Learn How Adobe Integrates Nielsen and Molich's Ten User Interface Design GuidelinesAdobe Systems Incorporated, the large North American computer software company, is a great example of how designs reflecting Nielsen and Molich’s
ten user interface guidelines can lead to success for a company. One of their most popular products, Adobe Photoshop, which is a raster graphics editor exhibits the characteristics of a well designed user interface that reflects these guidelines.We will take a closer look at how Adobe Photoshop reflects each of these guidelines in order to inspire you to
improve the usability, utility, and desirability of your own designs by incorporating the 10 rules of thumb into your own work.1. Visibility of System StatusPhotoshop does a great job of letting the user know what’s happening with the program by visually showing the user what their actions have led to whenever possible. For example, when users move
layers around in the Layers palette, they can visually see the layer being represented as physically dragged within the space.The cursor graphic goes from representing an open-hand to a gripped hand when the user drags a layer around within the Layers palette. This makes it easier to instantly understand the system status. Additionally, Adobe’s
choice of using a ‘hand’ is a great example of the second guideline where the system matches the real world.© Adobe Systems Incorporated, Fair Use2. System Match to the Real WorldAn example of Photoshop mimicking the real world in terms and representations that their target users would understand, is where they design the information
structure and terminology to mirror the same wording we would use in the world of photography or print media. Familiar concepts and terms like RGB, Hue/Saturation/Brightness and CMYK are used to represent color, while various tools like the dodge tool and the burn tool mimics a traditional darkroom technique for photographs.Photoshop’s
Dodge Tool and Burn Tool mimics a traditional darkroom technique for photographs© Adobe Systems Incorporated, Fair Use Photoshop utilizes the term, “Exposure”, as commonly used in the world of photography.© Adobe Systems Incorporated, Fair Use3. User Control and FreedomPhotoshop is very good at providing users with control every step
of the way. As the user makes changes to an image or adds various artistic effects, they are able to quickly and easily take a step backwards if they make an error, for instance.The users are in control as they can take a Step Backward or Step Forward under the Edit menu, or alternatively they can use Photoshop’s keyboard shortcuts like Alt+Ctrl+Z,
for example.© Adobe Systems Incorporated, Fair Use4. Consistency and StandardsPhotoshop maintains a standard layout and look and feel when it comes to the menu bar. They also utilize commonly known terminology such as “New...”, “Open...”, “Save As...”, etc.The File menu in Photoshop displays a variety of highly familiar options.© Adobe
Systems Incorporated, Fair Use5. Error PreventionTo prevent users from making errors, Photoshop provides a brief description or label of the tools when a user hovers over it to help make sure users are using the proper tool for the task at hand.The user hovers over the eraser icon and Photoshop displays the “Eraser Tool” label. © Adobe Systems
Incorporated, Fair Use Get your free template for “Bad UI Design Mistakes and How to Avoid Them” 6. Recognition rather than RecallWhether it be making a selection from the artistic filters menu, or opening a new image file, Photoshop provides a sample view for users to make the right choice. This allows for the user to visually recognize what
they’re looking for instead of having to recall the name or typing it in to search for it. Perhaps you have encountered other photo editing programs which ask you to recall and type the name of the file you want to work on. This can indeed be really difficult to recall as it is often something to the effect of: 29412 09342.JPG.The user is able to visually
recognize the sunset image by its thumbnail and select it.© Adobe Systems Incorporated, Fair Use7. Flexibility and Efficiency of UseOne of the many reasons for frequent users to love Photoshop is for its flexibility and efficiency. Users are able to utilize its flexibility by organizing and adding to their Workspace, as well as making things more efficient
by saving it for future use.Photoshop gives frequent users the ability to save their preferred workspace-setup.© Adobe Systems Incorporated, Fair Use8. Aesthetic and Minimalist DesignThe toolbar in Photoshop only displays the icons and is neatly tucked to the side to help keep clutter to a minimum, and maintain a minimalist aesthetic.The
Photoshop toolbar is minimalist and avoids clutter by representing the tools with icons only.© Adobe Systems Incorporated, Fair Use9. Help Users Recognize, Diagnose and Recover from ErrorsWhenever there is an error, Photoshop provides dialogue that lets the user know what went wrong and how to fix it.In this error message for the user’s
misuse of the clone stamp, Photoshop explains what went wrong, the reason why and how the user should proceed from there.© Adobe Systems Incorporated, Fair Use10. Help and documentationHelp and documentation can be accessed easily via the main menu bar. From there, you can find a wide variety of help topics and tutorials on how to make
full use of the program.The window displays information on how to create rollovers in the context of web graphics. The user is also able to see a list of topics on the side menu.© Adobe Systems Incorporated, Fair Usel0 Steps to Improve Usability, Utility, and Desirability by Implementing Nielsen and Molich’s User Interface Design GuidelinesAs a
designer, you should have the ability to critique the designs of your own as well as the work of others with well supported reasoning. Applying Nielsen and Molich’s 10 rules of thumb in evaluating interface design will help you recognize any potential issues as well as guide you and your team in creating better experiences for your users. Here’s a
worksheet for you to practice with as you learn the skill of recognizing whether or not these rules have been applied and when these rules have been violated. Finally, it’s time to improve the website or app by further implementing the 10 guidelines.Download PDF here.The Take AwayWhen you follow Nielsen and Molich’s 10 user interface guidelines
you will design with usability, utility and desirability in mind. Just as the designers of successful companies like Apple, Google, and Adobe, you’ll be able to support your design decisions with well researched heuristics and be confident in creating designs that are both usable and beautiful. To practice recognizing these 10 rules of thumb, go ahead
and work through the exercise outlined in the attached file from the above section.References and Where to Learn MoreTo find more information on Jakob Nielsen’s ‘Enhancing the Explanatory Power of Usability Heuristics’ please seeCourse: Ul Design Patterns for Successful SoftwareHero Image: Barry Schwartz. Flickr, CC BY-NC 2.0 Learn to
design with your user’s needs and expectations in mind by applying Jakob Nielsen and Rolf Molich’s Ten User Interface Guidelines. These heuristics have been reflected in many of the products designed by some of the most successful companies in the world such as Apple, Google, and Adobe. Further evidence of how their design teams incorporate
these rules into their design process is reflected in the user interface guidelines published and shared by these companies. This article will teach you how to follow the ten rules of thumb in your design work so you can further improve the usability, utility, and desirability of your designs.Nielsen and Molich's 10 User Interface Design GuidelinesJakob
Nielsen, a renowned web usability consultant and partner in the Nielsen Norman Group, and Rolf Molich, another prominent usability expert, established a list of ten user interface design guidelines in the 1990s. Note that there is considerable overlap between Nielsen and Molich's heuristics and Ben Shneiderman’s 'eight golden rules'. These 10
rules of thumb further iterate upon Shneiderman’s eight golden rules 4 years after Shneiderman’s initial publication.Visibility of system status. Users should always be informed of system operations with easy to understand and highly visible status displayed on the screen within a reasonable amount of time.Match between system and the real world.
Designers should endeavor to mirror the language and concepts users would find in the real world based on who their target users are. Presenting information in logical order and piggybacking on user’s expectations derived from their real-world experiences will reduce cognitive strain and make systems easier to use.User control and freedom. Offer
users a digital space where backward steps are possible, including undoing and redoing previous actions.Consistency and standards. Interface designers should ensure that both the graphic elements and terminology are maintained across similar platforms. For example, an icon that represents one category or concept should not represent a different
concept when used on a different screen.Error prevention. Whenever possible, design systems so that potential errors are kept to a minimum. Users do not like being called upon to detect and remedy problems, which may on occasion be beyond their level of expertise. Eliminating or flagging actions that may result in errors are two possible means of
achieving error prevention.Recognition rather than recall. Minimize cognitive load by maintaining task-relevant information within the display while users explore the interface. Human attention is limited and we are only capable of maintaining around five items in our short-term memory at one time. Due to the limitations of short-term memory,
designers should ensure users can simply employ recognition instead of recalling information across parts of the dialogue. Recognizing something is always easier than recall because recognition involves perceiving cues that help us reach into our vast memory and allowing relevant information to surface. For example, we often find the format of
multiple choice questions easier than short answer questions on a test because it only requires us to recognize the answer rather than recall it from our memory.Flexibility and efficiency of use. With increased use comes the demand for less interactions that allow faster navigation. This can be achieved by using abbreviations, function keys, hidden
commands and macro facilities. Users should be able to customize or tailor the interface to suit their needs so that frequent actions can be achieved through more convenient means.Aesthetic and minimalist design. Keep clutter to a minimum. All unnecessary information competes for the user's limited attentional resources, which could inhibit user’s
memory retrieval of relevant information. Therefore, the display must be reduced to only the necessary components for the current tasks, whilst providing clearly visible and unambiguous means of navigating to other content.Help users recognize, diagnose and recover from errors. Designers should assume users are unable to understand technical
terminology, therefore, error messages should almost always be expressed in plain language to ensure nothing gets lost in translation.Help and documentation. Ideally, we want users to navigate the system without having to resort to documentation. However, depending on the type of solution, documentation may be necessary. When users require
help, ensure it is easily located, specific to the task at hand and worded in a way that will guide them through the necessary steps towards a solution to the issue they are facing.Google Inc., the multibillion-dollar technology company, certainly produces designs that reflect the above heuristics. Jon Wiley, the head designer of Google Search in 2012
once said:“When I think of design and creating great user experiences, I generally think of it in terms of three things: usability, utility and desirability.”Nielsen and Molich’s 10 user interface guidelines cover these three key components of user experience quite nicely, which means you can likely improve the user experience of your designs by
following these guidelines!Learn How Adobe Integrates Nielsen and Molich's Ten User Interface Design GuidelinesAdobe Systems Incorporated, the large North American computer software company, is a great example of how designs reflecting Nielsen and Molich’s ten user interface guidelines can lead to success for a company. One of their most
popular products, Adobe Photoshop, which is a raster graphics editor exhibits the characteristics of a well designed user interface that reflects these guidelines.We will take a closer look at how Adobe Photoshop reflects each of these guidelines in order to inspire you to improve the usability, utility, and desirability of your own designs by
incorporating the 10 rules of thumb into your own work.1. Visibility of System StatusPhotoshop does a great job of letting the user know what’s happening with the program by visually showing the user what their actions have led to whenever possible. For example, when users move layers around in the Layers palette, they can visually see the layer
being represented as physically dragged within the space.The cursor graphic goes from representing an open-hand to a gripped hand when the user drags a layer around within the Layers palette. This makes it easier to instantly understand the system status. Additionally, Adobe’s choice of using a ‘hand’ is a great example of the second guideline
where the system matches the real world.© Adobe Systems Incorporated, Fair Use2. System Match to the Real WorldAn example of Photoshop mimicking the real world in terms and representations that their target users would understand, is where they design the information structure and terminology to mirror the same wording we would use in
the world of photography or print media. Familiar concepts and terms like RGB, Hue/Saturation/Brightness and CMYK are used to represent color, while various tools like the dodge tool and the burn tool mimics a traditional darkroom technique for photographs.Photoshop’s Dodge Tool and Burn Tool mimics a traditional darkroom technique for
photographs© Adobe Systems Incorporated, Fair Use Photoshop utilizes the term, “Exposure”, as commonly used in the world of photography.© Adobe Systems Incorporated, Fair Use3. User Control and FreedomPhotoshop is very good at providing users with control every step of the way. As the user makes changes to an image or adds various
artistic effects, they are able to quickly and easily take a step backwards if they make an error, for instance.The users are in control as they can take a Step Backward or Step Forward under the Edit menu, or alternatively they can use Photoshop’s keyboard shortcuts like Alt+Ctrl+Z, for example.© Adobe Systems Incorporated, Fair Use4. Consistency
and StandardsPhotoshop maintains a standard layout and look and feel when it comes to the menu bar. They also utilize commonly known terminology such as “New...”, “Open...”, “Save As...”, etc.The File menu in Photoshop displays a variety of highly familiar options.© Adobe Systems Incorporated, Fair Use5. Error PreventionTo prevent users from
making errors, Photoshop provides a brief description or label of the tools when a user hovers over it to help make sure users are using the proper tool for the task at hand.The user hovers over the eraser icon and Photoshop displays the “Eraser Tool” label.© Adobe Systems Incorporated, Fair Use Get your free template for “Bad UI Design Mistakes
and How to Avoid Them” 6. Recognition rather than RecallWhether it be making a selection from the artistic filters menu, or opening a new image file, Photoshop provides a sample view for users to make the right choice. This allows for the user to visually recognize what they’re looking for instead of having to recall the name or typing it in to search
for it. Perhaps you have encountered other photo editing programs which ask you to recall and type the name of the file you want to work on. This can indeed be really difficult to recall as it is often something to the effect of: 29412 09342.JPG.The user is able to visually recognize the sunset image by its thumbnail and select it.© Adobe Systems
Incorporated, Fair Use7. Flexibility and Efficiency of UseOne of the many reasons for frequent users to love Photoshop is for its flexibility and efficiency. Users are able to utilize its flexibility by organizing and adding to their Workspace, as well as making things more efficient by saving it for future use.Photoshop gives frequent users the ability to
save their preferred workspace-setup.© Adobe Systems Incorporated, Fair Use8. Aesthetic and Minimalist DesignThe toolbar in Photoshop only displays the icons and is neatly tucked to the side to help keep clutter to a minimum, and maintain a minimalist aesthetic.The Photoshop toolbar is minimalist and avoids clutter by representing the tools with
icons only.© Adobe Systems Incorporated, Fair Use9. Help Users Recognize, Diagnose and Recover from ErrorsWhenever there is an error, Photoshop provides dialogue that lets the user know what went wrong and how to fix it.In this error message for the user’s misuse of the clone stamp, Photoshop explains what went wrong, the reason why and
how the user should proceed from there.© Adobe Systems Incorporated, Fair Use10. Help and documentationHelp and documentation can be accessed easily via the main menu bar. From there, you can find a wide variety of help topics and tutorials on how to make full use of the program.The window displays information on how to create rollovers in
the context of web graphics. The user is also able to see a list of topics on the side menu.© Adobe Systems Incorporated, Fair Usel0 Steps to Improve Usability, Utility, and Desirability by Implementing Nielsen and Molich’s User Interface Design GuidelinesAs a designer, you should have the ability to critique the designs of your own as well as the
work of others with well supported reasoning. Applying Nielsen and Molich’s 10 rules of thumb in evaluating interface design will help you recognize any potential issues as well as guide you and your team in creating better experiences for your users. Here’s a worksheet for you to practice with as you learn the skill of recognizing whether or not
these rules have been applied and when these rules have been violated. Finally, it’s time to improve the website or app by further implementing the 10 guidelines.Download PDF here.The Take AwayWhen you follow Nielsen and Molich’s 10 user interface guidelines you will design with usability, utility and desirability in mind. Just as the designers of
successful companies like Apple, Google, and Adobe, you’ll be able to support your design decisions with well researched heuristics and be confident in creating designs that are both usable and beautiful. To practice recognizing these 10 rules of thumb, go ahead and work through the exercise outlined in the attached file from the above
section.References and Where to Learn MoreTo find more information on Jakob Nielsen’s ‘Enhancing the Explanatory Power of Usability Heuristics’ please seeCourse: UI Design Patterns for Successful SoftwareHero Image: Barry Schwartz. Flickr, CC BY-NC 2.0 Learn to design with your user’s needs and expectations in mind by applying Jakob
Nielsen and Rolf Molich’s Ten User Interface Guidelines. These heuristics have been reflected in many of the products designed by some of the most successful companies in the world such as Apple, Google, and Adobe. Further evidence of how their design teams incorporate these rules into their design process is reflected in the user interface
guidelines published and shared by these companies. This article will teach you how to follow the ten rules of thumb in your design work so you can further improve the usability, utility, and desirability of your designs.Nielsen and Molich's 10 User Interface Design GuidelinesJakob Nielsen, a renowned web usability consultant and partner in the
Nielsen Norman Group, and Rolf Molich, another prominent usability expert, established a list of ten user interface design guidelines in the 1990s. Note that there is considerable overlap between Nielsen and Molich's heuristics and Ben Shneiderman’s 'eight golden rules'. These 10 rules of thumb further iterate upon Shneiderman’s eight golden rules
4 years after Shneiderman’s initial publication.Visibility of system status. Users should always be informed of system operations with easy to understand and highly visible status displayed on the screen within a reasonable amount of time.Match between system and the real world. Designers should endeavor to mirror the language and concepts users
would find in the real world based on who their target users are. Presenting information in logical order and piggybacking on user’s expectations derived from their real-world experiences will reduce cognitive strain and make systems easier to use.User control and freedom. Offer users a digital space where backward steps are possible, including
undoing and redoing previous actions.Consistency and standards. Interface designers should ensure that both the graphic elements and terminology are maintained across similar platforms. For example, an icon that represents one category or concept should not represent a different concept when used on a different screen.Error prevention.
Whenever possible, design systems so that potential errors are kept to a minimum. Users do not like being called upon to detect and remedy problems, which may on occasion be beyond their level of expertise. Eliminating or flagging actions that may result in errors are two possible means of achieving error prevention.Recognition rather than recall.
Minimize cognitive load by maintaining task-relevant information within the display while users explore the interface. Human attention is limited and we are only capable of maintaining around five items in our short-term memory at one time. Due to the limitations of short-term memory, designers should ensure users can simply employ recognition
instead of recalling information across parts of the dialogue. Recognizing something is always easier than recall because recognition involves perceiving cues that help us reach into our vast memory and allowing relevant information to surface. For example, we often find the format of multiple choice questions easier than short answer questions on a
test because it only requires us to recognize the answer rather than recall it from our memory.Flexibility and efficiency of use. With increased use comes the demand for less interactions that allow faster navigation. This can be achieved by using abbreviations, function keys, hidden commands and macro facilities. Users should be able to customize or
tailor the interface to suit their needs so that frequent actions can be achieved through more convenient means.Aesthetic and minimalist design. Keep clutter to a minimum. All unnecessary information competes for the user's limited attentional resources, which could inhibit user’s memory retrieval of relevant information. Therefore, the display must
be reduced to only the necessary components for the current tasks, whilst providing clearly visible and unambiguous means of navigating to other content.Help users recognize, diagnose and recover from errors. Designers should assume users are unable to understand technical terminology, therefore, error messages should almost always be
expressed in plain language to ensure nothing gets lost in translation.Help and documentation. Ideally, we want users to navigate the system without having to resort to documentation. However, depending on the type of solution, documentation may be necessary. When users require help, ensure it is easily located, specific to the task at hand and
worded in a way that will guide them through the necessary steps towards a solution to the issue they are facing.Google Inc., the multibillion-dollar technology company, certainly produces designs that reflect the above heuristics. Jon Wiley, the head designer of Google Search in 2012 once said:“When I think of design and creating great user
experiences, I generally think of it in terms of three things: usability, utility and desirability.”Nielsen and Molich’s 10 user interface guidelines cover these three key components of user experience quite nicely, which means you can likely improve the user experience of your designs by following these guidelines!Learn How Adobe Integrates Nielsen
and Molich's Ten User Interface Design GuidelinesAdobe Systems Incorporated, the large North American computer software company, is a great example of how designs reflecting Nielsen and Molich’s ten user interface guidelines can lead to success for a company. One of their most popular products, Adobe Photoshop, which is a raster graphics
editor exhibits the characteristics of a well designed user interface that reflects these guidelines.We will take a closer look at how Adobe Photoshop reflects each of these guidelines in order to inspire you to improve the usability, utility, and desirability of your own designs by incorporating the 10 rules of thumb into your own work.1. Visibility of
System StatusPhotoshop does a great job of letting the user know what’s happening with the program by visually showing the user what their actions have led to whenever possible. For example, when users move layers around in the Layers palette, they can visually see the layer being represented as physically dragged within the space.The cursor
graphic goes from representing an open-hand to a gripped hand when the user drags a layer around within the Layers palette. This makes it easier to instantly understand the system status. Additionally, Adobe’s choice of using a ‘hand’ is a great example of the second guideline where the system matches the real world.© Adobe Systems
Incorporated, Fair Use2. System Match to the Real WorldAn example of Photoshop mimicking the real world in terms and representations that their target users would understand, is where they design the information structure and terminology to mirror the same wording we would use in the world of photography or print media. Familiar concepts
and terms like RGB, Hue/Saturation/Brightness and CMYK are used to represent color, while various tools like the dodge tool and the burn tool mimics a traditional darkroom technique for photographs.Photoshop’s Dodge Tool and Burn Tool mimics a traditional darkroom technique for photographs© Adobe Systems Incorporated, Fair Use Photoshop
utilizes the term, “Exposure”, as commonly used in the world of photography.© Adobe Systems Incorporated, Fair Use3. User Control and FreedomPhotoshop is very good at providing users with control every step of the way. As the user makes changes to an image or adds various artistic effects, they are able to quickly and easily take a step
backwards if they make an error, for instance.The users are in control as they can take a Step Backward or Step Forward under the Edit menu, or alternatively they can use Photoshop’s keyboard shortcuts like Alt+Ctrl+Z, for example.© Adobe Systems Incorporated, Fair Use4. Consistency and StandardsPhotoshop maintains a standard layout and
look and feel when it comes to the menu bar. They also utilize commonly known terminology such as “New...”, “Open...”, “Save As...”, etc.The File menu in Photoshop displays a variety of highly familiar options.© Adobe Systems Incorporated, Fair Use5. Error PreventionTo prevent users from making errors, Photoshop provides a brief description or
label of the tools when a user hovers over it to help make sure users are using the proper tool for the task at hand.The user hovers over the eraser icon and Photoshop displays the “Eraser Tool” label.© Adobe Systems Incorporated, Fair Use Get your free template for “Bad Ul Design Mistakes and How to Avoid Them” 6. Recognition rather than
RecallWhether it be making a selection from the artistic filters menu, or opening a new image file, Photoshop provides a sample view for users to make the right choice. This allows for the user to visually recognize what they’re looking for instead of having to recall the name or typing it in to search for it. Perhaps you have encountered other photo
editing programs which ask you to recall and type the name of the file you want to work on. This can indeed be really difficult to recall as it is often something to the effect of: 29412 09342.JPG.The user is able to visually recognize the sunset image by its thumbnail and select it.© Adobe Systems Incorporated, Fair Use7. Flexibility and Efficiency of
UseOne of the many reasons for frequent users to love Photoshop is for its flexibility and efficiency. Users are able to utilize its flexibility by organizing and adding to their Workspace, as well as making things more efficient by saving it for future use.Photoshop gives frequent users the ability to save their preferred workspace-setup.© Adobe Systems
Incorporated, Fair Use8. Aesthetic and Minimalist DesignThe toolbar in Photoshop only displays the icons and is neatly tucked to the side to help keep clutter to a minimum, and maintain a minimalist aesthetic.The Photoshop toolbar is minimalist and avoids clutter by representing the tools with icons only.© Adobe Systems Incorporated, Fair Use9.
Help Users Recognize, Diagnose and Recover from ErrorsWhenever there is an error, Photoshop provides dialogue that lets the user know what went wrong and how to fix it.In this error message for the user’s misuse of the clone stamp, Photoshop explains what went wrong, the reason why and how the user should proceed from there.© Adobe



Systems Incorporated, Fair Usel0. Help and documentationHelp and documentation can be accessed easily via the main menu bar. From there, you can find a wide variety of help topics and tutorials on how to make full use of the program.The window displays information on how to create rollovers in the context of web graphics. The user is also able
to see a list of topics on the side menu.© Adobe Systems Incorporated, Fair Usel0 Steps to Improve Usability, Utility, and Desirability by Implementing Nielsen and Molich’s User Interface Design GuidelinesAs a designer, you should have the ability to critique the designs of your own as well as the work of others with well supported reasoning.
Applying Nielsen and Molich’s 10 rules of thumb in evaluating interface design will help you recognize any potential issues as well as guide you and your team in creating better experiences for your users. Here’s a worksheet for you to practice with as you learn the skill of recognizing whether or not these rules have been applied and when these
rules have been violated. Finally, it’s time to improve the website or app by further implementing the 10 guidelines.Download PDF here.The Take AwayWhen you follow Nielsen and Molich’s 10 user interface guidelines you will design with usability, utility and desirability in mind. Just as the designers of successful companies like Apple, Google, and
Adobe, you’ll be able to support your design decisions with well researched heuristics and be confident in creating designs that are both usable and beautiful. To practice recognizing these 10 rules of thumb, go ahead and work through the exercise outlined in the attached file from the above section.References and Where to Learn MoreTo find more

information on Jakob Nielsen’s ‘Enhancing the Explanatory Power of Usability Heuristics’ please seeCourse: Ul Design Patterns for Successful SoftwareHero Image: Barry Schwartz. Flickr, CC BY-NC 2.0



